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Introduction to xHtml 
For more documentation on HTML, visit 
http://www.uwec.edu/help/html.htm 

HTML 
• HyperText Markup Language 
• Composed of: 

o Tags: <tagbeginning></tagend> 
o Attributes: something that changes a tag <tagbeginning 

attribute=”attributevalue”></tagend> 
 

Basic xHtml Webpage Structure 
 

<html> 
 <head> 
  <title>Webpage Title</title> 
 </head> 
 <body> 
  <p> 

Webpage content here. 
  </p> 
 </body> 
</html> 

Tag Definitions: 
For a complete list of Tag Definitions, and specifications visit    
http://www.w3schools.com/tags/default.asp 
 

<html></html> 
o Opens and closes the html page 

<head></head> 
o Opens and closes the head of the html page (not visible to user; 

meta, script tags, etc.) 
<title></title> 

o Opens and closes the title of the html page (appears in title bar. ex. 
PageTitle | Home  -Internet Explorer) 

<body></body> 
o Opens and closes the body of the html page (visible to user; 

content) 
<a href=”http://www.website.com/” target=”_self”></a>  

o Tags that surround a hyperlink 
 ../ 

• Moves up one directory (folder) 

http://www.uwec.edu/help/html.htm
http://www.w3schools.com/tags/default.asp
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 / 
• Moves into directory (folder) 

 Make all links relative  (ex:  ../images/picture.jpg) 
 NOT   c://document  OR  localhost://document 

<h1></h1> 
o Opens and closes a heading (h1-h6) 

<p></p> 
o Opens and closes a paragraph 

<img /> 
o Image 

<br /> 
o Line break 

<hr /> 
o Horizontal rule 

<div></div> 
o Opens and closes a div tag (used in CSS layouts) 

<span></span> 
o Opens and closes a span tag (used in CSS layouts) 

<!-- CommentHere --> 
o xHtml Comment (not visible to user) 

/* CommentHere */ 
o CSS Comment (not visible to user) 

<ul></ul> 
o Opens and closes an unordered list (bullets) 

<ol></ol> 
o Opens and closes an ordered list (numbered, lettered, etc.) 

<li></li> 
o Opens and closes a list point 

List Example: 
<ol> 
 <li></li> 
</ol> 

<table></table> 
o Opens and closes a table 
o <tr></tr> 

 Opens and closes a table row 
o <td></td> 

 Opens and closes a table data cell (column w/in row) 
Table Example: 

<table> 
 <tr> 
  <td></td> 
  <td></td> 
 </tr> 
 <tr> 
  <td></td> 
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  <td></td> 
 </tr> 
</table> 
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Introduction to Dreamweaver CS3 
Setting Up a Site in Dreamweaver: 

1. Open Dreamweaver 
2. Select Manage Sites in Files Tab  

 
3. Select New 

 
4. Name the site “SITA 2008” and click Next 

 
5. Select “No, I do not want to use a server technology” and click Next 
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6. Select “Edit local copies on my machine, then upload to server 
when ready [recommended]” 

 
7. Click on the folder icon to select where you want to put your files. 

Select “Desktop”  

 
8. Create a new folder. Rename it “SITA2008” (NO SPACES) 

 
9. Click your new SITA2008 folder and click Select. The path should 

look something like this: “C:\Documents and 
Settings\USERNAME\Desktop\SITA2008\” 
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10. Click the drop-down menu labeled “How do you connect to your 
remote server?” and select None. Click Next 

a. Note: if you want to connect to your web server directly, you 
would select Local/Network, etc., instead of None and input 
the appropriate information later in the wizard 

  
11. Click Done and then click Done again to complete the site setup  

 

Creating a New xHtml Document 
1. File > New > Blank Page > HTML > none 

 
2. Click Create 
3. Click on Code View  
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4. Give the page a title. Name it “SITA 2008 | YourNameHere” 

 
5. File > Save As… 
6. Save as “index” (Dreamweaver will automatically add a the correct 

file extension)(be sure that All Documents is selected in the Save 
as Type drop-down menu) 

a. Note: name the main page within any folder using index.html 
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Understanding Searches 
 

Crawler-based search engines have three major elements.  
o First is the spider, also called the crawler. The spider visits a web 

page, reads it, and then follows links to other pages within the site. 
This is what it means when someone refers to a site being "spidered" 
or "crawled." The spider returns to the site on a regular basis, such as 
every month or two, to look for changes. 

o Everything the spider finds goes into the second part of the search 
engine, the index. The index, sometimes called the catalog, is like a 
giant book containing a copy of every web page that the spider finds. If 
a web page changes, then this book is updated with new information. 
Sometimes it can take a while for new pages or changes that the 
spider finds to be added to the index. Thus, a web page may have 
been "spidered" but not yet "indexed." Until it is indexed -- added to the 
index -- it is not available to those searching with the search engine. 

o Search engine software is the third part of a search engine. It is the 
program that sifts through the millions of pages recorded in the index 
to find matches to a search and rank them in order of what it believes 
is most relevant.  

 
Major Search Engines: The Same, But Different 

o All crawler-based search engines have the basic parts described 
above, but there are differences in how these parts are tuned. Some 
search engines index more web pages than others. Some search 
engines also index web pages more often than others. The result is 
that no search engine has the exact same collection of web pages to 
search through. That naturally produces differences, when comparing 
their results. 

o This is why the same search on different search engines often 
produces different results.  
 

How Search Engines Rank Web Pages 
o Crawler-based search engines go about determining relevancy, when 

confronted with hundreds of millions of web pages to sort through, by 
following a set of rules, known as an algorithm. Exactly how a 
particular search engine's algorithm works is a closely-kept trade 
secret. However, all major search engines follow some general rules. 

o One of the main rules in a ranking algorithm involves the location 
and frequency of keywords on a web page. Call it the 
location/frequency method, for short. 
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o Pages with the search terms appearing in the HTML title tag are often 
assumed to be more relevant than others to the topic. 

o Search engines will also check to see if the search keywords appear 
near the top of a web page, such as in the headline or in the first few 
paragraphs of text. They assume that any page relevant to the topic 
will mention those words right from the beginning. 

o Frequency is the other major factor in how search engines determine 
relevancy. A search engine will analyze how often keywords appear in 
relation to other words in a web page. Those with a higher frequency 
are often deemed more relevant than other web pages. 

o Search engines may also penalize pages or exclude them from the 
index, if they detect search engine "spamming." An example is when 
a word is repeated hundreds of times on a page, to increase the 
frequency and propel the page higher in the listings. Search engines 
watch for common spamming methods in a variety of ways, including 
following up on complaints from their users. 

 
For better ratings: 

o Use descriptive <title> tags that include possible keywords. The title 
becomes the link that is displayed in the search results. If you do not 
have a <title> tag in your page, the page's URL becomes the link  

o Use descriptive text (not graphics) in the first few paragraphs of your 
page  

o Use descriptive terms for the alternate text description for all your 
graphics  

o Use <meta> description and keyword tags. If you have a <meta> 
description it will be used as the summary in the search results. If not, 
the first few words of text found on the page is displayed  

o Make sure the same keywords are reflected in the body of your page  
o Identify page contents using heading (<h#>) tags  
o Be careful not to repeat the same term too many times (referred to as 

"spamming") or your page will be penalized  
o Use JavaScript carefully! Text displayed using it is NOT indexed  

There is a difference in the way search engines treat the words entered in the 
search. 

OR   looks for either word on a page 
AND  looks for both words on a page 

Note: Common or meaningless words may be ignored
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META Tags 
 
See http://vancouver-webpages.com/META/mk-metas.html for more information 
and an easy-to-use META Tag Generator 

Where do META Tags go? 
META tags should be placed in the head of the HTML document, between the 
<HEAD> and </HEAD> tags. 

What are META Tags? 
Title (Strongly Recommended) 
Your document’s title will appear in user's hotlists, the banner of most browsers, 
and robot-generated lists. It should be a concise, one-line summary of what the 
page is about. Bear in mind that users may not reach your document through 
your homepage, but directly using a search engine or link at another site, so the 
title should ideally be self-sufficient.  
 
Keywords (Recommended) 
Comma-separated list of key words for indexing your document (i.e. word one, 
word two, separate, by, commas 
Some robots look at keywords in context, so it is best to preserve word order and 
case, e.g. pizza, Vancouver, British Columbia rather than british vancouver 
columbia pizza 
 
Description (Recommended) 
The description is presented to the user along with the document's title as the 
result of a search. 
Many robots use the first few lines of text as a description if the Description tag is 
not present. For an academic text, this should probably be the abstract.  
 
Owner (Optional) 
Legacy value. Some browsers (e.g. Lynx) use this to mail the document author; 
e.g. "JoeSmith@yoursite.com". 
 
Author (Optional) 
Name of author; e.g. “Joe Smith”. 
 
Language (Optional) 
Language of page; e.g. “English”. 
 
Charset (Optional) 
Charsets may be specified by the server; for instance: 
Content-type: text/html; charset=iso-8859-5 
(DEFINED BY DREAMWEAVER) 
 
Robots (Recommended) 

http://vancouver-webpages.com/META/mk-metas.html
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        <META NAME="ROBOTS" 
              CONTENT="ALL | NONE | NOINDEX | NOFOLLOW"> 
 
        default = empty = "ALL" 
        "NONE" = "NOINDEX, NOFOLLOW" 
The filler is a comma separated list of terms: 
ALL, NONE, INDEX, NOINDEX, FOLLOW, NOFOLLOW.  
 
Note: This tag is meant to provide users who cannot control the robots.txt file at 
their sites. It provides a last chance to keep their content out of search services. 
It was decided not to add syntax to allow robot specific permissions within the 
meta-tag.  
 
INDEX means that robots are welcome to include this page in search services.  
 
FOLLOW means that robots are welcome to follow links from this page to find 
other pages.  
 
So a value of "NOINDEX" allows the subsidiary links to be explored, even though 
the page is not indexed. A value of "NOFOLLOW" allows the page to be indexed, 
but no links from the page are explored (this may be useful if the page is a free 
entry point into pay-per-view content, for example. A value of "NONE" tells the 
robot to ignore the page.  

Example META Tags 
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" /> 
<meta name="description" content="place description here in sentence form" />  
<meta name="keywords" content="word one, word two, separate, by, commas 
"/>  
<meta name="Robots" Content="Noindex"> 
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More xHtml to Know 
 

Comments: 
Comments are important!!! Include one such as  

<!-- Created for the SITA 2008 Conference on 8-6-08 by TJS --> 
URLs:  

at least 4 parts – scheme (protocol), server, path, filename 
sometimes port & named anchor 

http://www.yoursite.com/folder/folder2/folder3/file.ext  
Scheme://server:port/path/file#anchor 

Links:   
• local path and relative path     

[Before linking, be sure LOCAL VIEW is showing and page is saved] 
• Targets  

_self (replaces page) 
_blank (new page) 

Lists: 
• Highlight the OL tag or the UL tag in the tag selector 
• Change STYLE as necessary 
• May access code and type in directly 

Spacing and Dividers: 
• Line Break: <br /> (shift+enter) 
• Horizontal Rule: <hr /> (or from the menu, Insert – HTML – Horizontal 

Rule)  

Tables:  
• Insert from menu or select COMMON tab on insert bar and click on table 

icon 
• Code generated includes <table>, <tr> for table row, <td> for table data 
• &nbsp; – non-breaking spaces used as place holders 
• Use Modify – Tables - Merge Cells to merge cells - rowspan, colspan 

attributes used 
• Cell padding – the space between a cell's border and its contents 
• Cell spacing – the number of pixels between each cell 
• Border = 0 provides an invisible table 
• Use Property Inspector to change the color of an individual cell 
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Images and Image maps:  
• If local, insert by drag and drop 
• Check out the Assets panel to see all images associated with your site. 

 
• EVERY IMG should have  an ALT !   
• Give each image map a unique name.  
• Each area should have a target – either _blank or _self 

o If one targets a new page, be sure to indicate to the user that a 
new page will open. 

• Be sure each area has an ALT as well.  
• For accessibility, each image link must have a corresponding text link 

somewhere on the page. 
• Three forms of hotspots – rectangle, oval, or polygon 

 
Testing the page:  

• Save the work then test with Preview in Browser (F12) 
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Templates in Dreamweaver 
About Templates 
In a template-based site, the layout is stored as a template with editable 
(changeable) and locked areas. Each individual page is then created by starting 
with the template containing information in the locked areas and adding 
information to the editable areas.  Styles are then linked to the template. Pages 
are then created from the template by just filling in the editable areas with 
different information. While each page created with the template can stand alone, 
there are advantages to keeping them associated with the template. 

• Two key advantages to templates:  
1. consistency – every page created from template will have the 

same basic look  
2. Maintenance – every page associated with the template will be 

automatically updated with any change made to the template. 
• Disadvantage – since all template code is included in each page created 

from the template, the overall site is a little larger. 

Creating and Applying a New Template 
WARNING: Dreamweaver must be pointing to the proper site; it must be pointing 
to the FOLDER in which you wish to create your pages…nothing more! 

1. Create a new template. File > New > Blank Template > Html 
Template > none > Create 

 
2. Insert an Editable Area. Insert > Template Objects > Editable 

Region (or Ctrl+Alt+V) (This area will be the only area unlocked 
and editable in the templated pages) 
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3. Save the template. Dreamweaver will automatically create a 
Templates folder. The template needs to be saved into this 
folder in order for it to work correctly. File > Save As… 

4. Save as master.dwt (Dreamweaver will automatically add a the 
correct file extension)(be sure that Template Files is selected in 
the Save as Type drop-down menu) 

 
5. Create a new xHtml document you’re your new template. File > 

New > Page from Template > SITA 2008 > master > Create 

 
6. Save this new templated document. File > Save As… 
7. Save as index.html (Dreamweaver will automatically add a the 

correct file extension)(be sure that All Documents is selected in 
the Save as Type drop-down menu) 

 



SITA 2008 – Dreamweaver CS3 I 18

Cascading Style Sheets (CSS) 
CSS Examples 
• CSS Zen Garden: examples of what CSS can do 

http://www.csszengarden.com/ 

About CSS 

Using Cascading Style Sheets gives the web publisher several advantages. 

• Saves time formatting web pages. 
• Easier to implement design changes. 
• Specifying units of measure can help promote a professional look. 
• Designer has more control of the appearance of the web site. 
• Browsers that do not recognize CSS will still display the page (but it may 

not be attractive).  

Terminology 
Cascading: the capability of a local style to override a general style. The 
more local to the tag a style is, the more overriding it is – so any local HTML 
styles directly in the code will override any rules located in the head section of 
the document, which in turn override any styles in an external style sheet. 
  External styles === Internal styles === Embedded (in-line) styles 
 
A style sheet is a collection of rules – instructions defining the styles. 

 .css is the extension of Cascading Style Sheets 
 External style sheets are linked to a document with a <link> tag. 

<link href="myStyles.css" rel="stylesheet" type="text/css"> 
 The External style sheet created for one page can be used by multiple 

pages. Link an external style .css to a saved document by clicking on 
the Attach Style Sheet button and browsing the list to find the .css file 
to be used. 

 Advantage of linking to an external style sheet – changes are 
automatically applied when the page linked to it is refreshed after 
changes to the style sheet have been made. 

 
A rule is made up of  
 (1) selector – either an HTML or custom style 
 (2) declaration – consisting of defined properties and values 

A style rule has two parts – the selector and the declaration 
       h1 { 

color: red; 
}  

http://www.csszengarden.com/
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h1 is the selector; the declaration is inside the { }  

Each item in the declaration is made up of two parts – the property 
and the value 
 h1 {color:red;} color is the property; red is the value 

 
A selector can be one of three types: 
 (1) Class – can be applied to any tag 

a. Class name begins with a period 
.redItalic {font-style: italic; color: #FF0000;} 

b. When applied to a selection, a SPAN tag surrounds the text 
<span class="redItalic">text here</span> 

c. Can be added directly in a tag with an inherent span 
<p class= “redItalic”>   

 (2) Tag – redefines the look of an existing HTML tag 
Rule applies to a single tag 

H1 {color: #006699;} 
 (3) Advanced – (IDs, contextual selectors, descendants, etc.) 

a. ID selector – applied to a single element; name of ID selector 
begins with # sign 

b. Descendant Selectors – contextual selectors specifying one tag 
within another 

ol ul ol {color: #FF0000; list-style-type: upper-alpha;} 
c. Combining declarations – rule applied to multiple tags 

h1, h3 {font-style: italic; color: #0000FF;} 
d. Others: 

A pseudo-class represents dynamic states of a tag that may 
change under user action or over time.  
The following four are the only pseudo-classes shown as options in 
the drop-down list for a selector.  a:link – customizes the style of a 
link that has not been visited recently 

 (only one seen in Design view) 
  a:visited – customizes style of link to a page that has 
been recently visited. 
  a:hover – customizes the style of a link while the 
user’s mouse is over it  

(not supported by all) 
  a:active – customizes the style of a link when it is 
selected by the user 
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A pseudo-element enables control over contextually defined page 
elements. Dreamweaver does not render any pseudo-elements in 
the preview. Test them in a browser. Just a few examples: 
  p:first-letter – styles the first letter of every paragraph 
tag 
  p:first-line – styles the first line of every paragraph tag 
 

o Format of the rule: selector {  
property : value ; 
property : value ; 

       } 
o Note that multiple declarations are separated by a semi-colon. 

Creating and Attaching a New CSS Document 
1. File > New > Blank Page > CSS 

 
2. Click Create 
3. File > Save As… 
4. Save the style sheet in the Templates folder created earlier 
5. Save as “styles.css” (Dreamweaver will automatically add a the 

correct file extension)(be sure that Style Sheets is selected in 
the Save as Type drop-down menu)  

 
6. Click on the master.dwt tab to view the index page 

 
7. Click on the Attach Style Sheet icon in the CSS tab 
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8. Click Browse. Select styles.css and click Ok. Be sure that Link 

is selected in Add As. Click Ok. 

 
9. Save master.dwt 

Styling and Formatting Utilizing CSS 
For more information on using and applying CSS, visit the following resources: 
• CSS Drive 

http://www.cssdrive.com/index.php/examples/ 
• Dynamic Drive CSS Library 

http://www.dynamicdrive.com/style/ 
• HTML Source: Stylesheets 

http://www.yourhtmlsource.com/stylesheets/ 
• Tizag CSS Tutorial 

http://www.tizag.com/cssT/index.php 
• Layout Gala 

http://blog.html.it/layoutgala/ 
To Redefine an HTML Tag 

1. In the Styles Panel, click the New CSS Rule icon 
2. Select Tag 
3. Select or type the tag to be redefined 
4. Make sure Define In “styles.css” is selected, NOT This 

Document Only 
5. Select the definitions for the style from the various categories. 

In the code view: 
o Format of the rule: selector {  

property : value ; 
property : value ; 

       } 
o Note that multiple declarations are separated by a semi-colon. 
 
To delete a style either –  

1. Remove the style rule from the code by hand or  

http://www.cssdrive.com/index.php/examples/
http://www.dynamicdrive.com/style/
http://www.yourhtmlsource.com/stylesheets/
http://www.tizag.com/cssT/index.php
http://blog.html.it/layoutgala/
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2. In the styles panel, select the style to be removed, then click the 
trash can 
 

Use the Advanced Option to Define a CSS Selector for either –  
1. assigning the same style rules to multiple existing HTML tags 
h1, h3 {color:#0000FF;}  causes both h1 tags and h3 tags to be 
blue 
Note – separate the listing of multiple tags with a comma! 
2. Applying one style to an HTML tag nested within another HTML 

tag 
p font { color:#FF0000;}  causes the words inside a local font tag to 
be red IF the font tag appears nested inside a paragraph tag 
Note – separate the nested tags with a space! 

• The order in which styles are defined is important.  
• The style most recently defined takes precedence over any others and affects 

the tag. 
To create a selection using the ADVANCED option 

1. In the Styles Panel, select Advanced 
2. If using one style for multiple tags, type in the tags separated by 

commas 
if creating one style for nested tags, type in the tags separated 
by spaces (be sure to start any DIV tag IDs with a # pound sign) 

3. Make sure Define In “styles.css” is selected, NOT This 
Document Only 

4. Select the definitions for the style from the various categories. 
To create a CUSTOM CLASS 

1. In the Styles Panel, select Class 
2. Name the new class using a . (period) in front of the name – the 

name must be unique and not the name of any other HTML tag 
3. Make sure Define In “styles.css” is selected, NOT This 

Document Only 
4. Select the definitions for the style from the various categories. 

o The results of creating a custom class will not be seen unless a span tag is 
used to surround the selected elements to be changed by the custom class. 

o The value of the class attribute in the span tag is the name of the style to be 
applied.     

<span class=“RedItalic”>text here</span> 
o If the custom tag is applied to a tag that has an inherit span, such as the 

paragraph, then the class attribute is just added as an attribute of the tag.  
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<p align="left" class = “RedItalic”>text here</p> 
o Dreamweaver tries to avoid nested spans by splitting up the spans.   
 
ALL CSS styles … using the <STYLE> 
element 

a. Rules stored in head of document using 
style tag; rules inside comment; multiple 
declarations separated by semi-colons. 

b. Affects existing HTML tags in document 
such as <body> <p> <OL> <H1> without 
adding code in the body of the document 

c. Changes to rules immediately change all 
existing instances of the tag 

d. The order in which rules appear is 
important. 

 
<style type="text/css"> 
<!-- 
p { 
 color: #000066; 
 background-color: 
#999999; 
} 
--> 
</style> 
</head> 

o The style tag has the type attribute set to "text/css". 
o A comment surrounds the entire set of rules so older browsers incapable of 

using styles will ignore this section of code. 
 
Quick Review: 
External style sheet – styles, located in external file, generally applied to the 
page to which it is linked 
Internal styles – located in head of the page in the STYLE tag, overrides any 
styles in the external CSS 
Embedded or In-line styles – located in within the Body, override any internal or 
external styles 
 
Style sheets can be prepared for a printer by adding the media = “print” 
attribute to the link tag or for the screen by adding the media = “screen” 
attribute (optional). 

<link href="myStyles.css" rel="stylesheet" type="text/css" 
media=“screen”> 

Understanding the CSS Rule Definition Dialog Box Options 
(As taken from UWEC online documentation referenced at the end of this document) 

The CSS Rule definition dialog box consists of eight different categories of 
definition.  

• Type  
• Background  
• Block  
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• Box  
• Border  
• List  
• Positioning 
• Extensions  

Type Options 

The Type category defines the most basic CSS components. The Type category 
determines the appearance and format of text for the selected style. Its options 
include font style, size, weight, case, color, and text decoration.  

 

Font 
Specify the font style or font family from the Font pull-down list. If your desired 
font is not listed, you can edit the list of available fonts. 

To keep the same appearance across all browsers and platforms, be sure to use 
a “Web-Safe” Font. For more information on web-safe fonts, visit 
http://www.codestyle.org/css/font-family/sampler-CombinedResults.shtml 

Size 
Specify a size and measurement system for the specified font using the Size pull-
down list. You may also type a size in the Size text box.  

Weight 
Specify the weight, or boldness, of text. You can select predetermined settings 
from the Weight pull-down list, or type a weight value in the Weight text box. 
HINT: The weight of normal text is 400 and the weight of bold text is generally 
700. 

http://www.codestyle.org/css/font-family/sampler-CombinedResults.shtml
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Style 
Specify normal, oblique, or italic attributes for your text. 

Variant 
Specify normal or small-caps.  
NOTE: Small-caps is a font style that displays all letters in uppercase. 

Line Height 
Specify the leading, or height of a line of text, and its system of measurement. 
HINT: To maintain sufficient white space between lines, line height is usually set 
a couple of points higher than the font size. For an overlapping effect, you can 
set the line height a couple of points lower than the font size. 

Case 
Specify uppercase, lowercase, or capitalized attributes for your text. 

Color 
Specify the text color by typing the color name, color value, or select a color from 
the Color box. 

Decoration 
Specify the decoration for text by selecting from the available options: overline, 
underline, line-through, blink, or none. 

Background Options 

The Background category allows you to specify background color and any 
background images you wish to include. Furthermore, you can set the image 
location on the page and determine whether or not the image is repeated. 
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Background Color 
Specify the background color by typing the color name, color value, or select a 
color from the Color box.  

Background Image 
Specify a background image by typing the filename and path or by browsing to it. 

Repeat 
Specify the tiling options for a background image:  

• No repeat 
One instance of the image is displayed in the upper-left corner.  

• Repeat 
The background image is tiled horizontally and vertically (left to right, top 
to bottom).  

• Repeat-x 
The background image is tiled horizontally.  

• Repeat-y 
The background image is tiled vertically.  

Attachment 
Specify whether the background image remains fixed in its original position or 
scrolls with the page. 

Horizontal Position 
Specify left, right, center, or value (in pixels) for the horizontal position of a 
background image. 
NOTE: The default position for all background images is the top left-hand corner 
of a page. All selections made from this option will impact the default position.  

Vertical Position 
Specify top, center, bottom, or value (in pixels) for the vertical position of a 
background image. 
NOTE: The default position for all background images is the top left-hand corner 
of a page. All selections made from this option will impact the default position.  

Block Options 

You can space and align text manually with the Block category. 
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Word Spacing 
Specify the spacing between words by selecting a negative or positive value from 
the Word spacing pull-down list. 

Letter Spacing 
Specify the spacing between the letters of words by selecting a negative or 
positive value from the Letter spacing pull-down list. 

Vertical Alignment 
Specify the vertical alignment of text in relation to the line of text. 

Text Align 
Specify text alignment by selecting left, right, center, or justified. 

Text Indent 
Specify indents for text by selecting a value and system of measurement. 

Whitespace 
Determine the appearance of extra spaces and tabs, which are usually collapsed 
by default. Pre preserves all white space, and nowrap wraps text when a <br> 
tag is present. 

Display 
Specify whether, and if so how, an element will be displayed (e.g., block, table, 
inline, table-row) from the Display pull-down list.  

Box Option 

The Box category is primarily used to define the spacing and placement of 
elements (e.g., images) on a page. 
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Width 
Specify the element's width. 

Height 
Specify the element's height. 

Float 
Specify left, right, or none to determine which side elements such as text, layers, 
and tables will float in relation to other page content.  

Clear 
Keep a layer from appearing on a selected side of an element. 

Padding 
Specify the amount of space separating the element and the border or margin. 
You can specify padding values for the Left, Right, Top and Bottom 
independently.  

Margin 
Specify the amount of space between the borders of the element and other 
elements on the page by designating values for the Left, Right, Top and Bottom 
independently. 

Border Options 

The Border category allows you to specify border styles, width, and color values 
for the borders of text, images, and other web elements. You can designate 
values for individual border edges, or apply one value to all.  
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Style 
Specify a border style from the following options: none, dotted, dashed, solid, 
double, groove, ridge, inset, outset. 

Width 
Specify a border width from thin, medium, or thick, or type a value in any of the 
Width text boxes. 

Color  
Specify the border color by typing the color name or color value, or select a color 
from the Color box.  

List Options 

You can control styles and types of bulleted lists with CSS. The CSS Rule 
definition dialog box allows you to choose custom bullet images, list types, and 
different positioning options. 
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Type 
Specify the display type of bullets from the following pre-existing options: disc, 
circle, square, decimal, lower-roman, upper-roman, lower-alpha, upper-alpha, 
and none. 

Bullet Image 
Specify a custom bullet image or browse to select one. 

Position 
Specify whether the list item wraps and indents (outside) or wraps to the left 
margin (inside). 

Positioning Options 

The Positioning category prescribes the position or placement of CSS elements. 
This greatly increases a designer's creative control over the appearance of a web 
page. Positioning options allow you to place an element in the exact position you 
would like it to appear on the web page.  

 

Type 
Specify the element's positioning from the following options:  

• Absolute: an element's positioning is stable on the page, regardless of 
the positioning of other element  

• Fixed: an element's positioning is relative to the top left corner of the 
browser window  

• Relative: an element's positioning corresponds with that of the other 
elements on the page  

• Static: an element's positioning is disabled; the element is displayed as it 
would be in regular HTML  
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Visibility 
Specify whether an element is visible or hidden on the web page. 

Width 
Specify the width of an element and the system of measurement. 

Z-Index 
Specify the depth of an element within layers (higher values are closer to the 
top). 

Height 
Specify the height of an element and the system of measurement. 

Overflow 
Specify how the element should be displayed when a portion of it extends 
beyond the allotted space: visible, hidden, scroll, or auto.  

Placement 
Specify the placement and dimensions of an element. 

Clip 
Specify the visible portions of an element. 

Extensions Options 

The Extensions category allows you to specify page breaks for printing, change 
insertion point images, and customize the appearance of various elements.  

 

Page Break 
Specify a point for printers to read a page break. 
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Cursor 
Specify the cursor type that appears when the mouse moves over a certain 
element. 

Filter 
Customize the appearance of an element without using animation or graphic files 
(e.g., blur).  

Insertion Point Options Illustrated 

The following table illustrates the options available for specifying the cursor 
image that appears when the mouse moves over a certain element. 

Option Cursor Image Option Cursor Image

Hand  N-resize  

Crosshair  NW-resize  

Text  W-resize  

Wait  SW-resize  

Default  S-resize  

Help  SE-resize  

E-resize  Auto  
NE-resize      

 

http://www.uwec.edu/help/DreamweaverCS3/css-stydefmore.htm#filter#filter
http://www.uwec.edu/help/DreamweaverCS3/css-stydefmore.htm#cursor#cursor
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Resources 
Dreamweaver CS3 Documentation 
http://www.uwec.edu/help/dwCS3.htm 

HTML 4.01 / XHTML 1.0 Reference 
http://www.w3schools.com/tags/ref_byfunc.asp 

META Tag Builder 2 
http://vancouver-webpages.com/META/mk-metas.html 

Web-Safe Fonts 
http://www.codestyle.org/css/font-family/sampler-CombinedResults.shtml 
CSS Zen Garden 
http://www.csszengarden.com/ 

CSS Drive 
http://www.cssdrive.com/index.php/examples/ 

Dynamic Drive CSS Library 
http://www.dynamicdrive.com/style/ 

HTML Source: Stylesheets 
http://www.yourhtmlsource.com/stylesheets/ 

Tizag CSS Tutorial 
http://www.tizag.com/cssT/index.php 

Layout Gala 
http://blog.html.it/layoutgala/ 

Dynamic Drive DHTML Library 
http://www.dynamicdrive.com/style/ 

Big Webmaster Resources 
http://www.bigwebmaster.com/ 

FavIcon Creator 
http://www.chami.com/html-kit/services/favicon/ 

Kuler Color Scheme Picker 
http://www.chami.com/html-kit/services/favicon/ 

W3C HTML Validator 
http://validator.w3.org/ 

W3C CSS Validator 
http://jigsaw.w3.org/css-validator/validator.html.en 

http://www.uwec.edu/help/dwCS3.htm
http://www.w3schools.com/tags/ref_byfunc.asp
http://vancouver-webpages.com/META/mk-metas.html
http://www.codestyle.org/css/font-family/sampler-CombinedResults.shtml
http://www.csszengarden.com/
http://www.cssdrive.com/index.php/examples/
http://www.dynamicdrive.com/style/
http://www.yourhtmlsource.com/stylesheets/
http://www.tizag.com/cssT/index.php
http://blog.html.it/layoutgala/
http://www.dynamicdrive.com/style/
http://www.bigwebmaster.com/
http://www.chami.com/html-kit/services/favicon/
http://www.chami.com/html-kit/services/favicon/
http://validator.w3.org/
http://jigsaw.w3.org/css-validator/validator.html.en
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